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Desktop Setup 

The Desktop Setup process on the Setup menu allows you to specify for each user type the 

settings necessary to create the screen used to log into People-Trak and to create the desktops. 

The desktop settings affect some of the “look” of the desktops, but most of the content of the 

desktops are defined in Company Setup and User Setup. 

The Desktop Setup screen uses several tabs to record and maintain setup information for the 

Login screen and desktops. The available user types are listed on the left.  

Login Settings Tab 
The Login Settings tab is used to specify key settings needed for the Login screen. 

Each of the fields on this tab is used to specify what a certain part of the Login screen will 

look like or what text it will contain. This includes the Login Caption, Login Welcome Text, 

and the Login Image. 

Desktop Tab 
The Desktop tab is used to specify key settings needed for the desktops. Overall settings 

include the color scheme, desktop alignment, and maintaining the color scheme. Web settings 

include the default web page width, client height, choosing to use a custom header, the web 

header height, and the heading logo image.The Use Whole Screen checkbox on this tab 

allows you to expand the background form and fill the entire monitor. Clear the check box for 

the background image to remain the fixed size.  

Note: Since this feature is at the desktop level, if the setting is set for a certain user type, all 

users of that type get the desktop.   

Logos and Header Tab 
The Logos and Header tab is used to select the logos and specify the header settings for the 

enterprise. These settings are listed and defined below. 

 Document Logo 

 Heading Logo 

 Enterprise Header Only 

 Include Header Text 

 Header Text Alignment 

 

The Document Logo field is supported by the Select Image popup so the appropriate image 

can be selected and the Clear Image popup so an existing image can be cleared. The 

dimensions of this image are 206 pixels wide by 74 pixels high.    

Heading Logo field is supported by the Select Image popup so the appropriate image can be 

selected and the Clear Image popup so an existing image can be cleared. The dimensions of 

this image are 1040 pixels wide by 80 pixels high.  

 
Note: If the image itself is not as big as the dimensions provided, it is important that it be 

sized big enough (using white space for example) to accommodate the placement of header 

text if that option is being used. Otherwise, the header text will not be visible.    
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The Enterprise Header Only check box allows you to specify whether or not to use the 

enterprise header for the desktops in addition to the Login screen. Select the check box to 

only use the enterprise header; this means that the company logo and name will not be used in 

the desktop headers. Clear the check box to use the enterprise header on the Login screen and 

the company header on the desktops. 

The Include Header check box allows you to specify whether or not you want the header text 

included in the header of the Login screen and desktops. Select the check box to include the 

header text in the header. Clear the check box to not include any header text in the header.   

The Header Text alignment field is used to selecte thee alignment used for the header text. 

This field is supported by the Select Position popup. If they Include Header Text check box is 

not selected, which means the header text is not even shown, this alignment is irrelevant. 

Additional settings on this tab include the name, style, size, and color of the font to be used 

for the header text.  

Organizer Tab 
The Organizer tab is used to specify what modules are active in the modules pane of the 

Organizer desktop. 

Tasks Tab 
The Desktop Tasks tab is used to define the default desktop tasks for the selected user type. 

These tasks can then be used to populate the tasks for individual users within User Setup. 

Tasks from all modules are available for inclusion in this list of desktop tasks. This allows the 

user to easily access any tasks, without needing to switch modules or find the options on 

menus. 

Multi-User Environment 

People-Trak is a multi-user product. You can define almost any number of individual users, 

and they can access People-Trak simultaneously. It is very important that each user have a 

unique user ID.  

By design, the System Administrator is the only person who should be performing User 

Setup. It provides access to all user profiles and has no internal security. If a user can access 

this menu item, the user can add, delete, and modify users at will.  

User Types 

The user type is assigned to a People-Trak user in User Setup and determines what People-

Trak desktop and functionality is available to that user.  

People-Trak supports the following user types: 

 HR - HR User  

 Employee - Employee Self-Service User (ESS) 

 Manager - Manager Self-Service User (MSS) 

 Ex-Employee- Ex Employee Self Service User (Ex-e) 

 Applicant –Career Center User (CC) 

 Visitor - Visitor User 

 

The HR user type is the only one available in the base People-Trak Essential HR product. The 

Employee, Manager, and Ex-Employee user types are added when Self Service 
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Employee/Manager has been implemented. The Applicant and Visitors are added with the 

implementation of Self Service Recruiting. 

User Setup 

The Desktop Setup process on the Setup menu allows you to specify for each user type the 

settings necessary to create the screen used to log into People-Trak and to create the desktops. 

The desktop settings affect some of the “look” of the desktops, but most of the content of the 

desktops are defined in User Setup. 

The User Setup screen uses six tabs to record and maintain key user information, setups and 

defaults.  

Login Tab 
The Login tab is used to specify ID and status settings. These settings are listed and defined 

below. 

 User ID 

 Password 

 User Type 

 User Active 

 Last PW Change 

 Grace Logins Used 

 Password Question 

 Password Answer 

 

The User ID is a unique phrase that identifies the user. Many organizations standardize user 

IDs in one of two formats. The first format is the first initial of the first name followed by the 

complete last name. For example: John Smith becomes "jsmith". The second format is the 

full first name followed by the first initial of the last name. For example: John Smith becomes 

“johns”. Either format or any format you select will work up to the maximum of ten 

characters allowed. 

Note: Make certain that each user has a unique user ID. The user ID is used in naming 

temporary files. If users share an ID, the temporary files for the first user will be deleted 

when the second user signs in. This could cause a disruption in processing for the first user. 

The Password entered must meet the minimum length requirement as specified in the 

Minimum Length field in Enterprise Setup. If the Letters and Numbers check box is selected 

in Enterprise Setup, the password must also contain a combination of letters and numbers. 

Along with the user ID, the password forms a unique combination that grants access to 

People-Trak and determines which features will be available. The password entered with the 

User Setup process (selected from the Setup menu) can be changed by the user with the 

Change Password option (selected from the Tools menu).When the password is typed in, 

asterisks are displayed for security purposes. In addition, the password is encrypted when 

stored in the database. 

The User Type is the type of the user. In the base People-Trak Essential HR product, the only 

valid user type is HR, and this field is display only. One thing the user type controls is when 

the User ID/Password combination is valid. For example, if the user type is HR, the User 

ID/Password combination is only valid when logging in as an HR user. 

The User Active check box allows you to specify whether or not the user is active. Select the 

check box to make the user active. Clear the check box to make the user inactive. If the user 

is not active, he cannot log into People-Trak.When a user is locked out because of exceeding 
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the login attempt limit or grace logins (set in Enterprise Setup), the user is automatically set 

to inactive by clearing this check box. The System Administrator would have to select this 

check box for that user in order to give the user access to People-Trak again. 

The date of the last password change is found in the Last PW change field. This field is 

system maintained but can be manually changed if required. 

Grace Logins Used is the number of grace logins used out of the number allowed. This field 

is display only and is system maintained. The number of grace logins allowed is set in the 

Grace Logins field in Enterprise Setup. Every time the user logs in without changing his 

password when a change is required, he will use one of his grace logins and this Grace 

Logins Used counter will be incremented. For example, if the Grace Logins count in 

Enterprise Setup is 3 and the user just used his first grace login, this counter will say “1 of 3”. 

The Password Question is the question to display when the Forgot your Password link is 

clicked on the Login screen after the User ID for this user has been entered. 

The Password Answer is the answer to the question entered in the Password Question field. If 

a user forgets his password, he must enter his User ID and then click the Forgot your 

Password link. The Password Question is displayed, and the user must enter the correct 

answer, as specified in this Password Answer field. When the correct answer is entered, the 

password for the user is mailed to the Email Address specified for the user here in User 

Setup. 

Note: This answer is case sensitive, so how you enter it here is exactly how it must be entered 

when using the Forgot your Password link. 

Preferences Tab 
The Preference tab is used to specify user preference settings. These settings are listed and 

defined below. 

 Scheme Name 

 Default Company 

 Default Module 

 Alarm Frequency 

 Lookup Limit 

 Enable Preselect 

 Inbox on Login 

 Run on Double –Click 

 Auto-Delimit 

 Email Closing 

 

The Scheme Name is the name of the color scheme to use for the user’s desktops and screens. 

This field is supported by the Select Color Scheme popup, which includes a list of color 

schemes. People-Trak is shipped with several color schemes, but you can define your own 

using the Maintain Color Schemes utility, which can be accessed by clicking the Define 

Colors button on this tab. 

The Default Company is the company to which the user is defaulted when logging in. The 

user can switch to any other company to which access has been granted after log in. This field 

should be set to the company that the user most frequently uses. This field is supported by the 

Select Company popup. 

The Default Module is the module to be made the current module when this user logs in. The 

user can switch to any other module to which access has been granted after login. This field 
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should be set to the module that the user most frequently uses. This field is supported by the 

Select Module popup. 

The Alarm Frequency is the number of minutes between each check for alarms. The default 

setting for this field is 5 minutes. This means that alarms will be checked every 5 minutes. If 

you would like to increase this length of time for this user, you may choose to check alarms 

every 10, 30 or 60 minutes. There is also a 1 minute option, but this should be used only if 

absolutely necessary as it will slow system processing time. 

The Alarm Frequency setting also controls how often the Inbox counter is refreshed. This 

counter shows how many items you have in your Inbox and is displayed below the Inbox icon 

on the Organizer Shortcut Bar. If the Alarm Frequency is set to 5 minutes, the Inbox counter 

will be updated every 5 minutes with the current number of items in your Inbox. 

The Lookup Limit is the number of records to show when a lookup is run. The default setting 

for this field is 0, which means that all qualifying records are to be shown. Changing this 

setting is only required if you have a very large number of records in the database, which 

would increase the time taken for a lookup. If you do choose a value for the Lookup Limit 

that is then less than the number of qualifying records in a lookup, the lookup results will 

state that the assigned record limit has been enforced. If you do not choose a value for the 

Lookup Limit and the number of qualifying records is greater than 5000, a Lookup Limit of 

5000 is automatically enforced. 

The Enable Preselect check box allows you to specify for this user whether or not an entry is 

pre-selected when the cursor is first positioned to a field. Windows normally pre-selects the 

entire entry. If you inadvertently press any key, the entire existing entry is replaced with that 

key. The People-Trak standard interface does not pre-select existing data, so this check box is 

cleared. If you would like the entire entry to be pre-selected, select this check box. 

The Inbox on Login checkbox allows you to specify whether or not the Inbox will be 

displayed when the user logs in. Once you have closed the Inbox and moved deeper into 

People-Trak, the Inbox can be reactivated in the Organizer desktop with a single click on the 

Inbox icon on the Shortcut Bar or by selecting the Inbox option on the Tools menu.   

The Run on Double-Click check box allows you to specify which action to take when the 

user double-clicks on a document in the Explorer. If this option is checked, the document will 

run when you double-click on it. If this option is not checked, the appropriate document 

editor screen is opened when you double-click on a document. 

The Auto- Delimit checkbox allows you to specify whether or not you want date delimiters 

automatically entered for you when entering a date. If this check box is selected, only 

numbers can be entered in a date field and the delimiter specified in the PC’s regional date 

format setting is automatically entered in the correct positions. If this check box is not 

selected, numbers and a delimiter of “.”, “/” or “-” can be entered in a date field, and the field 

is formatted to the PC’s regional 10-character date format after it is entered. For example, if 

you type in “3.4.9” and press ENTER, the date will be formatted to 03-04-2009 if the PC’s 

date format is m-d-yyyy,  mm-dd-yyyy or some variation of that. 

The Email Closing field is used to specify the email closing template for an email. This 

closing is specified for the current user .This field is supported by the Email Closing 

Template. You can add this closing to the email text area by clicking the Add Closing button 

on the Send Email screen. 

User Task Preferences 
The Copy from Desktop button replaces the selected user’s tasks with the default tasks that 

were defined for their user type in Desktop Setup. 
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The Define Tasks button displays the Desktop Tasks defined for the selected user. Tasks may 

be updated using the Copy from Desktop button or by manually entering tasks. 

Identity Tab  
The Identity tab is used to specify the employee ID, contact information and digital signature.  

Standard Workflows Tab 
The Standard Workflows tab is used to specify for each user the screens to be displayed in 

each standard workflow and in what order.  

Select the user and module for which you want to change the standard workflow. In the 

Screens frame, select the check boxes for screens to which you want the user to have access 

or clear the check boxes for screens to which you don’t want the user to have access. You can 

also click the Up and Down buttons to move screens to another location in the display order. 

Quick Search Tab 
The Quick Search tab lists the modules the user has access to and specifies the Lookup 

Favorite to be used for each module when the Quick Search button is clicked by this user 

when looking up records.  

User Variables 

The follow system variables are taken from the similarly-named fields that are maintained in 

the User Setup process. These variables reflect the currently logged in user. This is useful 

when the same form or letter is to be used by multiple users, but is to be signed by the user 

actually producing the report. The name of the user actually producing the particular letter is 

substituted into the letter. 

 User Name  

 User Phone  

 User Extension 

 User Fax 

 User Signature 

 User Email 

 User Title 
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This lesson covers how to specify the key settings in the Desktop Setup process. 

Tutorials 
Specifying Login Settings: shows how to change how the Login screen looks by changing 

the settings and images used by the Login screen.  

Specifying Default Desktop Settings: shows how to change how the Login screen looks by 

customizing the color scheme used by the Login screen.  

Specifying Logos and Header Settings: demonstrates how to determine what logo should 

display on documents as well as what should display in the header area of the Login screen 

and desktops. 

Organizer Tab: specify which modules are accessible within the modules pane of the 

Organizer desktop 

Specifying Default Desktop Tasks: shows how to assign the default desktop tasks for a user 

type. 
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Tutorial 1.1 – Specifying Login Settings 

The Login Settings tab of the Desktop Setup process allows you to change how the Login 

screen looks by changing the settings and images used by the Login screen. Let’s take a look 

at each of these settings. 

1. On the Setup menu, select Desktop Setup. 

 

The Desktop Setup screen is displayed with the Login Settings tab open. 

2. In the Login Caption field, enter the caption you would like to have on the Login screen. 

3. In the Login Welcome Text field, enter the text you would like to have in the welcome 

area of the Login screen. 

4. Click in the Login Image field, and then click the Select Image popup button. 

 

The Select File screen is displayed. 

5. In the PT9\SAMPLES directory of your local People-Trak drive, select PETE 

WELCOME.JPG.  

 

This image will be displayed on the right side of the Login screen and should be sized to 

260 pixels wide by 260 pixels high.  

6. Click the Desktop tab. 

The Color Scheme field allows you to specify a color scheme to be used for the desktop 

7. In the Color Scheme field, select the popup to display the Select Color Scheme screen. 

8. Select London Fog, which is a gray scheme that will go nicely with the picture we are 

going to choose for the login image. 

9. Close the Desktop Setup screen, saving your changes. 

 

We are ready to see how our changes affected the Login screen.  

10. Click the Logoff shortcut on the Shortcut Bar. 

 

The Login screen is displayed using the London Fog color scheme and the Login Image 

you chose of Pete the People-Stik cruising on by. The Login Caption you entered is 

displayed as the caption. The Login Welcome Text is displayed as the welcome below 

the caption. We will learn about the heading settings for the Login screen in a future 

tutorial 

11. Log in as DEMO/DEMO.  

Notice that the desktop color scheme changed to the one assigned to the DEMO user, 

which is Charcoal Mint. The color scheme within Desktop Setup is only used for the 

Login screen, before the user is known. We will take a closer look at user desktop 

settings in User Setup. 

12. On the Setup menu, elect the Desktop Setup menu option and return to the Desktop tab 

once again.  
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We’re done playing with colors so let’s set the color scheme for the default desktop back 

to Charcoal Mint. Later training assumes that you have the data colors set to those in that 

scheme.  

13.  In the Color Scheme field, change the color scheme back to Charcoal Mint.  

14. Stay on the Desktop tab and continue with the next tutorial. 

  



Lesson 1 

 

10     Desktop and User Setup 
 

Tutorial 1.2 – Specifying Default Desktop Settings 

The Desktop tab of the Desktop Setup process allows you to determine default settings for the 

desktop that include overall settings such as alignment and colors and specifications for the 

web.  

1. You should still be on the Desktop tab within Desktop Setup. 

2. Click the Set Colors button, which is in the upper-right corner. 

 

The Color Schemes screen is displayed. You have automatically run the Maintain Color 

Schemes utility, which is also available from the Utilities menu. Charcoal Mint is 

highlighted in the list on the left, and the colors shown on the right are the ones assigned 

to that color scheme.  

The standard color schemes that are shipped with People-Trak cannot be changed. Since 

we want to play with some colors, we will first need to create a new color scheme in 

order to do so. We can either copy the current color scheme or create a new one that is 

based off the Classic Blue color scheme. Let’s use the copy feature so we can keep our 

cool mint colors and just change the data colors a bit. 

3. On the File menu, select Copy Color Scheme. 

 

The current color scheme is copied to a new color scheme called Charcoal Mint-1. 

4. Change the Scheme Code to My Color Scheme. 

First, let’s take a look at the frame and background colors.  

The fields in the Frame and Background Colors frame are currently using the colors 

assigned to the Charcoal Mint scheme: the Light Color is a pale mint color, Medium is a 

pale light green, and the Dark Color is an evergreen shade. Let’s spruce things up by 

picking some new colors.   

5. In the Light Color field, click the popup button. 

6. The Select Color popup is displayed.  

For the time being, we will stick with the eleven basic colors 

7. Click on Yellow.  

The Light Color field is changed to the yellow color you chose 

8. Click OK. 

9. In the Medium Color field, click the popup button. 

10. Click on Orange.  

The Medium Color field is changed to the orange color you chose 

11. Click OK. 

12. For the Dark Color field, repeat the same steps to select and change that color to Red. 



Desktop Setup 

 

 Desktop and User Setup     11 

 

13. Click the Preview button. 

You can see what your current colors will look like in the preview screen on the right-

hand side of the screen. 

With the frame and background colors decided on, why don’t we take a look at data 

colors? 

The fields in the Data Colors frame are currently using the data colors assigned to the 

Charcoal Mint scheme: Normal is Blue, Modified is Red, Mask is Yellow and Pending is 

Magenta. Let’s change some of them.   

14. In the Normal Color field, click the popup button. 

 

The Select Color popup is displayed. We can pick one of the eleven basic colors as we 

did earlier, or we can get creative and make a custom color. Let’s get creative! 

15. Select Custom. 

 

The Color screen is displayed with the current color (Blue) displayed in the Color|Solid 

area. This color just happens to be a basic color, so that square is highlighted in the Basic 

Colors. This shade of blue is also circled by dashes in the spectrum area and arrowed on 

the slider bar. The six color settings depict that color as well. 

 

Choosing a color can be as simple as selecting from one of the 48 basic colors. Let’s do 

that for the Normal color. 

16. Click on one of the green shades in the Basic colors section. 

 

All of the settings on the right side of the screen are changed accordingly.  

If you are really fond of a color and want to use it again, you can add it to the Custom 

Colors section. 

17. Click the Add to Custom Colors button. 

 

Your custom green color is added to the next available square in the Custom Colors 

section and can be easily selected in the future. 

18. Click OK to select your custom color. 

19. Select OK on the Select Color popup. 

 

The Normal Color field is changed to the green color you chose. 

20. In the Modified Color field, use what we have just learned to select a custom blue shade 

of your choice. 

The Modified Color field is changed to the blue color you chose 

21. Click OK. 

22. In the Mask Color field, select a grey shade using either color selection method. 

23. Click OK. 
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24. Now try to change the Modified Color to the same color you used for the Normal 

Color. 

 

You won’t be able to do so. This is because the Normal, Modified, Mask and Pending 

colors must all be unique. In your case the Normal Color is a certain shade of green, so 

the three other color fields cannot be that shade of green. In addition, the Normal, 

Modified and Pending colors cannot be white because the background color on text boxes 

is white and the white text would be completely lost in the white background. All four 

colors should also be noticeably different from the gray color that is used for display 

only. 

 

The Pending Color field is used when approvals are being used. We won’t take time to 

demonstrate that, but the color is changed just like the other data colors. 

25. Click the Preview button to see what your data colors will end up looking like in action. 

Let’s give our minds and eyes a well deserved break and move on. We won’t be changing 

any other colors in this demonstration.  

26. Close the Color Schemes screen, saving your changes. 

Before leaving the Desktop tab, let’s make sure that we change the color scheme to 

something other than the mess of colors we have just created. 

27. In the Color Scheme field, select London Fog as the new default desktop color. 

28.  Close the Desktop Setup screen saving your changes. 

You may notice that our desktop colors have not changed. While we did change the 

default desktop settings for the HR user type, we still need to update these settings for our 

individual users. We will have the opportunity to do this in a future lesson when we learn 

about User Setup. Before we do that, we have a few more important areas to cover within 

Desktop Setup. 

29. Continue with the next tutorial.  
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Tutorial 1.3 – Specifying Logos and Header Settings 

The Logos and Header tab of the Desktop Setup process allows you to determine what logo 

should display on documents as well as what should display in the header area of the Login 

screen and desktops. 

1. On the Setup menu, select Desktop Setup. 

2. Click the Logos and Header tab. 

 

The Document and Heading Logo fields allow you to select what logos you would like to 

use when the enterprise header is being used. You select these like you saw earlier in the 

Company Setup training. Since we want to demonstrate how the header text settings work 

in this tutorial, we will need to change our Heading Logo to be one that does not already 

include text. 

3. In the Heading Logo field, click the leftmost popup button to select the image. In the 

PT9\SAMPLES directory of your local People-Trak drive, select 

ZTI_BANNER_NO_TEXT.JPG.  

4. Click on the Enterprise Header Only check box to select it.  

By selecting the Enterprise Header Only check box, we will set all desktop headers and 

as wells as the header on the login screen to the Heading logo that we just selected in 

Desktop Setup. 

5. Double click on the Include Header Text check box to select it.  

The Include Header Text check box allows you to include the heading text in the 

enterprise header. You would want to clear this check box if your enterprise heading logo 

has the heading text already in it. This was the case with our original logo, however, as 

we mentioned earlier, our new Heading Logo does not. 

The Header Text Alignment field allows you to choose how you want the heading text 

aligned. This field is only used when the Include Header Text check box is selected. 

6. Leave the Header Text Alignment set to Right. 

 

The last four settings allow you to specify the font and color to use for the text.  

7. In the Name field, use the popup to select whatever font settings you want. 

8. In the Color field, choose your favorite color. 

 

Let’s see how the settings you just made affect the headers on the Login screen and 

desktops. 

9. Close the Desktop Setup screen, saving your changes. 

10. Click the Logoff shortcut on the Shortcut Bar. 

 

The Login screen is displayed with the header including the enterprise heading logo on 

the left and the enterprise name justified to the right, using your font and color choices. 
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11. Log in as DEMO / DEMO. 

 

The Organizer desktop is displayed. Since you chose to use the enterprise header only, 

the enterprise header is displayed here just like on the Login screen.  

 

Let’s show you what a short logo looks like in the heading. We will change our company 

header to use that and then switch back to using company headers again. 

12. On the Setup menu, select Desktop Setup. 

13. Click the Logos and Header tab. 

14. In the Heading Logo field, select ZTI_ACTIVE_SHORT_LOGO.JPG from the 

PT9\SAMPLES directory of your local People-Trak drive. 

15. Close Desktop Setup, saving your changes. 

 

The heading has changed to display the current company’s short logo but the company 

name is not displaying. This is because the image we used is not wide enough to have the 

company name text overlaid upon it. The image must be as wide as what you want to 

display in the heading. We recommend that all Heading Logo images be sized to 1040 

pixels wide by 74 pixels high, which matches the size of the heading area of the desktop. 

Let’s pick an image that has the correct dimensions. 

16. On the Setup menu, select Desktop Setup. 

17. Click the Logos and Header tab. 

18. In the Heading Logo field, select ZTI_ACTIVE_BANNER_NO_TEXT.JPG from the 

PT9\SAMPLES directory of your local People-Trak drive. 

 

This logo looks just like the Document Logo but is in fact wider using white space to 

extend the image. 

19. Clear the Enterprise Header Only check box.  

 

Company headers will now print on the desktops. 

20. In the Header Text Alignment field, enter Left. 

21.  Close the Desktop Setup screen, saving your changes. 

 

This time the heading displays both the logo and the name. Note that the name is left 

justified in the area available for the heading text. As you can see, Desktop Setup controls 

the text alignment for both the enterprise and company headers. 

22. Click the Logoff shortcut on the Shortcut Bar. 

 

The Login screen is displayed and now includes the enterprise logo with the name left 

justified this time. The enterprise header always prints on the Login screen, unless you 

are using custom headers and footers, which is available on the Web. 

23. Log in as DEMO / DEMO. 
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The Organizer desktop is displayed. The header area contains the company logo and 

name.  

 

Let’s return our desktop and login header settings back to where they were when we first 

started. 

24. On the Setup menu, select Desktop Setup. 

25. Click the Logos and Header tab. 

26. In the Heading Logo field, select ZTI_BANNER_HR.JPG from the PT9\SAMPLES 

directory of your local People-Trak drive. 

27. Clear the Include Header Text check box. 

28. Close Desktop Setup, saving your changes 

The company header (and the enterprise header, which you can’t see yet) is now back to 

the way it was when we started. 

 

As you have seen, the headings on the Login screen and desktops can be customized to 

exactly what you desire. 

29. Continue with the next tutorial. 
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Tutorial 1.4 – Organizer Tab 

The Organizer tab is used to specify which modules are accessible within the Modules pane 

of the Organizer desktop. In this tutorial you will learn how to adjust these settings according 

to your desktop preferences. 

1. On the Organizer desktop, take a look at the modules listed in the Modules pane. 

Of all the modules we have access to; perhaps we aren’t utilizing Contact Management at 

this point in time. And by removing it from the Modules pane, it is one less   

2. On the Setup menu, select Desktop Setup. 

3. Click the Organizer tab.  

A list of the available modules is displayed. Each module has a checkbox that has been 

selected. But not for long. 

4.  Select the Contact Management module and clear its check box.  

5. Close the Desktop Setup screen, saving your changes. 

The Contact Management module is no longer in the Modules pane of the Organizer 

desktop. 

Multiple modules can be removed using the same steps. 

6. On the Setup menu, select Desktop Setup. 

7. Click the Organizer tab.  

8. Clear the checkboxes for the remaining modules except for Personnel Management. 

9. Close the Desktop Setup screen, saving your changes. 

Personnel Management is the only module within the Modules pane. This change is 

extreme, but luckily it is only temporary.  

10. On the Setup menu, select Desktop Setup. 

11. Click the Organizer tab.  

Re select all cleared checkboxes to activate the modules once again. 

12. Close the Desktop Setup screen, saving your changes. 

The modules have been returned to the Modules pane and it is as if nothing ever 

happened. 

13. Continue with the next tutorial. 

 

 

  



Desktop Setup 

 

 Desktop and User Setup     17 

 

Tutorial 1.5 – Specifying Default Desktop Tasks 

In this tutorial, you will learn how to assign default desktop tasks to a user type, which will 

then be used to populate and update Desktop Tasks within User Setup. 

1. On the Setup menu, select Desktop Setup. 

2. Click the Tasks tab.  

Let’s start fresh by deleting all the existing tasks.  

3. On the Tool Bar, select the Delete Row button to delete all the existing tasks. 

You have a choice of having tasks for a user organized by groups. Group names can be 

anything you want. If you do choose to use groups, it is important that all tasks for each 

group be kept together in the tasks grid.  

 

Our training database uses the group option, so we’ll add our new tasks to a group as 

well. 

4. In the Group column of the first blank row, enter My HR Activities.  

5. As you leave the field, the following message is displayed: 

Entry is not in the table, Override Table? 

6. Click Yes. 

7. In the Module column, click the popup button. 

The Select Module popup is displayed with a list of the modules that this user has access 

to. 

8. Select the Personnel Management module and select OK. 

9. In the Task Type column, click the popup button. 

The Select Task Type popup is displayed with a list of the task types that this user has 

access to. 

10. Select the Activity task type and select OK. 

11. Try entering a task name directly into the Task Name field. You cannot.  

 

Because of the complexity of this selection process, you must use the popup button to 

select a task. 

12. In the Task Name column, click the popup button. 

Since we selected Activity for our task type the Select Activity popup is displayed with a 

list of the activities within the Personnel module that this user has access to. 

13. Select the Employee Manager activity. 

The Display Name field for this task is defaulted to the Task Name but can be changed.  
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We can use the same methods to add a few more tasks to our task list. 

14. Select the Save icon. 

15. In the Group column of the second blank row, enter My HR Workflows.  

16. As you leave the field, the following message is displayed: 

Entry is not in the table, Override Table? 

17. Click Yes. 

18. Select the Personnel Management module and add a Create task that uses the 

Standard- Employee workflow. 

19. Select the Save icon and move to the next blank row. 

20. In the Group column, select the popup button. 

Remember the two tasks we just saved? By saving those tasks, we were able to store the 

group names in a table. For future tasks that may be in the same group, we can simply 

select the group name from this table instead of rekeying it. 

21. Select the My HR Workflows group. 

22. For this task, select the Safety Management module and add an Edit task that uses the 

Standard- Incident workflow. 

23. In the next row, select the Benefit Administration module and add a Document task 

type. 

24.  Use the Select Document popup to select the Benefit Plan Enrollment by Employee 

report from the Benefit category in Adhoc Reports. 

25. In the next row, select the Safety Management module and add a Processing task type. 

26. Use the Select Processing popup to select the Claim Cost Batch. 

For our final task, we are going to add a link, which is done a bit differently than our 

other tasks. First of all, we don’t need to specify a module; however, we do need to select 

what type of task we are adding. 

27. In the Task Type field, use the popup to select the Link task type.  

28. Select OK to return to the Tasks tab. 

29. In the Task Name field enter www.shrm.org. 

The Display Name is defaulted to the URL, but as we mentioned, this can be changed. 

30. In the Display Name column, enter the following: 

SHRM Home Page 

31. Close the Desktop Setup screen, saving your changes. 

http://www.shrm.org/
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We will be taking a closer look at how the default desktop tasks are updated for 

individual users in an upcoming tutorial. 

32. Continue with the next tutorial. 
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This lesson covers the key settings in the User Setup process. 

Tutorials 
Adding/Deleting Users: demonstrates how to add and delete users. 

Setting User Preferences: shows how set the preferences for individual users. 

Changing Default Settings at the User Level: demonstrates how modify the default 

preferences for individual users. 

Changing Standard Workflows: demonstrates how to change the standard workflows for a 

user. 
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Tutorial 2.1 – Adding/Deleting Users 

This tutorial describes how to add and delete users. 

1. On the Setup menu, select User Setup.  

 

When you first enter the User Setup screen, the user ID you used to access People-Trak 

(DEMO in this case) becomes the current user record being edited. You can use the list of 

users to select any other user for editing. 

2. On the File menu, select New User or on the Tool Bar, click the New User button to add 

a new user.  

 

A new user is created with a temporary User ID of “NEW-” concatenated with the next 

sequential number available. In our case, that User ID is NEW-1 since that code did not 

exist yet. As you can see, this is the same naming scheme that was used when we added a 

new company. 

 

Your new user is now your current user for editing purposes. At this point you would 

enter all the information for this new user, but let’s demonstrate the Copy User feature to 

see how this can save you some time if you have an existing user that is similar to the 

new user you want to create. This is very similar to the Copy Company feature you 

learned about in the last lesson. Let’s assume the user that is similar to the one we want to 

create is the DEMO user. 

3. Highlight the DEMO user. 

4. On the File menu, select Copy User. 

 

A new user is created with a User ID of DEMO-1, which is the User ID of the user you 

copied concatenated with a dash and the next sequential number available. In addition, 

the settings for the DEMO user are copied to the new user, except the Password field. 

You can look at the other tabs if you wish to verify this. In addition, the security settings 

(specified in Security Setup and Security Setup – Module) for DEMO are copied to the 

new user. 

5. Change the User ID of the new user from DEMO-1 to JSMITH. 

 

Normally, you would enter the correct user ID per your naming conventions. Typical user 

IDs are composed of the first letter of the user’s first name followed by their last name 

(but you may use any system that works for you). 

6. Assign a Password to the new user.  

 

This can be a temporary password that the user can replace using the Change Password 

process once he or she has accessed People-Trak. As you type in the password, asterisks 

are displayed for security purposes. In addition, the password is encrypted when stored in 

the database. 

7. Select the Preferences tab. 

 

The Default Company and Default Module fields are the same as the DEMO user you 

copied. We will leave these fields as is. 

8. Click the Identity tab.  
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9. In the Employee ID field, click the popup button. 

 

The Lookup screen is displayed. 

10. Click Search and then highlight any employee. Click OK.  

 

Note that the Full Name through Digital Signature fields have had information brought in 

from the Employee record and are display only.  

 

If you have users that are not employees, such as consultants, you would leave the 

Employee ID field blank, and enter the following fields manually. 

11. Click the Standard Workflows tab.  

 

The DEMO user currently has the standard workflows for each module set up in the same 

way that the standard workflows are shipped, with all screens on and in that same order. 

We will take a closer look at this tab in an upcoming tutorial. 

12. Click the Quick Search tab 

The DEMO user did not have a Quick Search Favorite assigned for any of the modules, 

so the new user does not have any either.  

We have seen how the addition of a new user is accomplished. Now, let’s delete this user. 

13. On the File menu, select Delete User or on the Tool Bar, click the Delete User button to 

delete the user. You will be asked to confirm the deletion. Go ahead and delete the user. 

We will leave NEW-1 user alone for now, as we will be using them in an upcoming 

tutorial. 

 

Note: In a live environment, you will want to delete users with caution because 

documents owned by those users are also deleted. If the user you want to delete is the 

owner of any documents that you want to keep, you will need to copy those documents to 

another user or to the COMMON user first. 

14. Continue with the next tutorial. 
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Tutorial 2.2 – Setting User Preferences 

In this lesson, we will take a look at just a few of the user preferences that can be specified on 

the Preferences tab of User Setup. 

1. You should still be in the User Setup screen. Select the DEMO user. 

2. Select the Preferences tab. 

The Enable Preselect check box field determines whether text boxes (stand alone and in 

grids) are to be treated in the Windows way or in the People-Trak way. At this point, the 

check box should not be selected.  

3. Move the cursor around and note that with preselect not enabled, the entry in the field is 

not pre-selected. 

4. Change the interface to the Windows standard by selecting the Enable Preselect check 

box. 

 

In order to see this change take effect, you must close User Setup and save your changes. 

5. Close the User Setup screen, saving your changes. Select User Setup option again. 

6. Now, move the cursor from field to field, and you will see that the contents of each field 

are pre-selected.  

 

If you touch a key when the contents are pre-selected, the contents are replaced with the 

key you pressed. This scares people and is why People-Trak is shipped with preselect 

disabled. It is a better way to meet the heavy data entry requirements of a personnel 

management product. 

7. Clear the Enable Preselect check box. 

 

Now, on to the Auto-Delimit feature. People-Trak is shipped with the Auto-Delimit 

feature turned on, which automatically puts the appropriate delimiter (from your PC’s 

regional format settings for dates) in dates for you; all you need to do is type the 

numbers. If you prefer to type in your own delimiters, you can turn this feature off. You 

have already seen the delimiters put in for you in the Intro to PT training, so let’s turn off 

this feature and see how that works. 

8. Clear the Auto-Delimit check box. 

 

We can use the Last PW Change date field on this screen to demonstrate this setting, but 

we need to close the screen and come back into it in order for the setting change to take 

effect. 

9. Close the User Setup screen, saving your changes. 

10. Select the User Setup option again and stay in the Login tab area. 

11. Clear the Last PW Change field and then type 119 and press ENTER.  

 

No delimiters are automatically placed for you, and you receive an invalid date message. 
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12. Clear the Last PW Change field and then type 1.1.9 and press ENTER. 

 

The date is formatted according to your PC’s regional format settings for dates. Our date 

examples assume a “m-d-yyyy” setting so “01-01-2009” is displayed. Note that you did 

not have to put in “01-01-2009” but could use date “shorthand”. You can use the “.”, “-” 

or “/” delimiters when you type in a date and upon pressing ENTER, the date will be 

formatted according to your PC’s regional 10-character date format after it is entered. 

 

Let’s turn the Auto-Delimit feature back on before we head to the next tutorial. 

13. Switch to the Preferences tab 

14. Select the Auto-Delimit check box and stay in the User Setup screen.  

15. Continue with the next tutorial. 

   



Lesson 2 

 

26     Desktop and User Setup 
 

Tutorial 2.3 – Changing Default Settings at the User Level 

In a prior lesson, we defined the default desktop colors and tasks for our HR users. Within 

this tutorial, we will be learning how these default settings can be changed for individual 

users. 

1. You should still be in the User Setup screen on the Preferences tab. 

2. Select the NEW-1 user.   

Notice that the scheme name for our NEW-1 user has been set to London Fog, the default 

that we recently changed in Desktop Setup. Every time a new user is created, they are 

assigned the default color scheme.  

You may recall that we defined default desktop tasks as well. When the NEW-1 user was 

created, they automatically inherited those tasks. We check on that now. 

3. Select the Define Tasks button. 

The Desktop Tasks screen is displayed along with the tasks we defined. 

4. Close the Desktop Tasks screen. 

Our newest user is up to date with the defaults. For our existing users, however, we may 

need to do some housekeeping. 

5. Select the DEMO user.  

The color scheme is still set to Charcoal Mint which is not the default.  

6. Select the Define Tasks button. 

The tasks haven’t been updated to the defaults either.  

Let’s synch the DEMO user with Desktop Setup. 

7. Close the Desktop Tasks screen. 

8. Select the Copy from Desktop button. 

The DEMO user’s color scheme has changed to London Fog. We still need to take a look 

at their desktop tasks. 

9. Select the Define Tasks button. 

The Desktop Tasks screen is displayed with the updated set of tasks. A successful 

synchronization has occurred! 

10. Close the Desktop Tasks screen. 

Some users may not prefer having default settings assigned, and may request color 

schemes and task based on their individual preferences. User settings can be easily 

changed as we will find out with the DEMO user.  

First, let’s change the default desktop colors for the DEMO user. 
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11. In the Scheme Name field, select the Charcoal Mint color scheme. 

And with that, the desktop colors are changed. If the DEMO user was a bit pickier about 

colors, we could modify this color scheme like we did in Desktop Setup. But for now, 

this color scheme is perfect. 

Now we can move on to modifying the DEMO user’s tasks. 

12. Select the Define Tasks button to display the Desktop Tasks screen. 

13. Highlight the task in the first row. 

14. On the Tool Bar, select the Insert Row button to add a new blank row. 

Let’s add an administrative task that will only be for our DEMO user. 

15. In the Module column, use the popup to select the Personnel Management module. 

16. In the Task Type column, use the popup to select the Administration task type. 

17. In the Task Name column, use the popup to select the Adhoc Reports task. 

18. Click the Save button to save all of these changes. 

The DEMO user now has the ability to run, create, and maintain adhoc reports from their 

list of tasks. They have been uniquely set apart from the other users who have only been 

given the default desktop tasks. 

Speaking of being unique, users may also have a set of tasks that is specific to them. We 

will take a look at how this is done, once again with our DEMO user. 

19. Highlight the task in the first row, which should be the newly added administration task. 

20. On the Tool Bar, select the Delete Row button to delete all the existing rows. 

21. Leave the Group column blank and add three different activity tasks from the COBRA 

Administration module. 

There you have it! Changing and updating tasks on a user level is as simple as that.  

22. Close the Desktop Tasks screen, saving your changes. 

23. Close the User Setup screen, saving your changes. 

Since future lessons assume that we are using the Charcoal Mint color scheme, we should 

change our default desktop settings back to reflect this. 

24. On the Setup menu select Desktop Setup. 

25. On the Desktop tab, use the popup in the Scheme Name field to select the Charcoal 

Mint color scheme.  

26. Close the Desktop Setup screen, saving your changes. 

27. Continue with the next tutorial. 
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Tutorial 2.4 – Changing Standard Workflows 

People-Trak is shipped with a standard workflow for each module. The naming convention is 

“Standard - Record ”, where Record is the name of the record maintained by that module. For 

example, the Personnel Management module maintains the Employee record, so the 

workflow for that module is “Standard-Employee”. Each user can have his own version of the 

standard workflow. Let’s see how to do this. 

1. On the Setup menu, select User Setup 

2. Click the Standard Workflows tab.  

 

The first module in the Modules pane, Personnel Management, is selected. All of the 

screens in the Screens pane are selected. The DEMO user is defaulted to having all of the 

standard workflows be the same as what is shipped with People-Trak. So, what you are 

seeing as the order in the Screens pane is the same as the shipped Standard - Employee 

workflow for the Personnel Management module. 

3. Select Safety Management in the Modules pane. 

 

The Screens pane now displays the screens for the Standard - Incident workflow for the 

Safety Management module. Let’s go back and change the Standard  - Employee 

workflow for the Personnel Management module. 

4. Select Personnel Management in the Modules pane. 

 

To remove a screen from being displayed in a workflow, just clear the check box for that 

screen. 

5. In the Screens pane, click Status, which will highlight that check box. Click Status 

again, which will clear that screen’s check box. 

  

You can also change the order of the screens. 

6. In the Screens pane, click Compensation, and then click the Up button twice to move 

the Compensation screen up to the top of the Screens pane. 

 

The Compensation screen is now our first screen and the Status screen will no longer be 

displayed. 

7. Close the User Setup screen, saving your changes. 

8. Click the Open Employee shortcut on the Shortcut Bar and select any employee.  

 

As you specified, the Compensation screen is the first screen displayed.   

9. Click the Screen dropdown button. 

 

You can see that the Personal screen is next in the list and there is no Status screen after 

that. We have changed the standard workflow, but only for this user. 

10. Close the dropdown, and close the employee. 
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11. On the Setup menu, select User Setup. 

 

Let’s change the DEMO user’s Standard - Employee workflow back to the way it was. 

12. On the Standard Workflows tab, move the Compensation screen back down to being 

third in the list of screens. Select the Status screen’s check box so it will be included 

once again.  

13. Close the User Setup screen, saving your changes. 

14. Exit People-Trak. 

15. This concludes this tutorial and lesson.  

 

 

 


